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Our summer edition of DIGI T presents all the better. We are after all the 
pictures accepted for the Members' Print Digital Imaging Group 
Exhibition. I hope you will agree that this year we and we should welcome 
have another great exhibition and one which once new vision and 
again illustrates the breadth and depth of our imcrprelations of rea li ty 
..;embers· work and styles. One aspect that is of from our ever-increasing 
particular interest this year is the range of membership. There's 
treatments and methods that have been used to room for everyone! 
realise the vision or the author. Sometimes the Clive HtltJVl-tS FR.PS 
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treatment is quite obvious and is an integral pait of 
the visualisation, while for others it's very subtle 
and we are scarcely aware that any image­
management has been made. 
Whenever photographers and digital imagers 
gather to discuss images there·s a group of topics 
that are certain to polarise opinion. Broadly 
speaking these relate to questions about what is 
val id , when is photography not photography and 
the oft heard accusation of'cheating·. 1 would like 
to take a few moments to exam ine some of these 
contentions. 
The Digital Imaging Group caters for a very wide 
range of photography. in fact just about anything, 
and this of course is one of our strengths: that of a 
broad church wherein we can appreciate 
everything from traditional landscapes lo natural 
history and from fine art portraits to avant-garde 
expressionism. The common currency for us all 
however remains the captured image. whether by 
a traditional camera system. a scanner or 
something altogether more experimental. For my 
part so long as the captured image/photograph 
remains centra l to the work then it fits within my 
concept of photography. A photograph can be the 
complete work or a starting point. When an image 
is managed, manipulated or improved the 
decisions are those of the author and cries of 
cheating can only really be applied in cases of 
plagiarism. The purpose of an image is to 
communicate and/or to evoke a response. If one is 
confined 10 a set of arbitrary rules, or the need to 
please judges. then we sound the death knell of art 
and progress further along the road to mediocrity. 
Occasionally c1iticism is levelled at the use of 
filters. Yes, of course tilters can be overdone and 
applied without thought. However the exploitation 
of filters and effects can provide stimulat ion and 
stepping-stones to altogether unsu pectcd 
destinations. Our colleagues should be 
encouraged to experiment and try new ideas and 
not to be afraid of the establishment and possible 
scorn from the less advemurous and blinkered. 
The imaoe remains central and it'. very unlikely 

"' and indeed quite rare fo r a poor original picture to 
be turned into something stunningly beautiful and 
appealing by the simple application of a tilter. 
Once again the image is the starting point and a 
strong initial image will inevitably lead to greater 
realisation and success. T would be the last person 
to c1y halt to the application of filters and 
experimentation - the more the merrier I say. The 
greater the range of application and new ideas the 

Clfre Hayues FRPS 
C/l(lir111a11 

!PORTFOLIO TWO NEEDS You! 
For publication ia the aunimn of 20 I 0. 
PORTFOLIO TWO follows the successful 
PORTFOLIO ONE, published in 2007. It will 
include features on the work of Award winning 
pbotographers and eminent members, there will 
be sections on Distinctions sbowi ng a wide 
variety at all levels, Groups, Regions, Overseas 
Chapters' activities, selections from Society 
Exhibitions, work from imaging science, and a 
look at the RPS Collection linking with the 2009 
Visual Literacy Conference, The Real Thing? -
Staging, Manipulation and Photographic Truth, 
tooether with a view of infrared photography on e, 

the 100th anniversary of first publication in The 
Journal. All articles will be image-led. 
All members are invited to submit their best 
imaoes for inclusion in the large Members' 

"' . Gallety. Your pictLtres are important to us. As 1t 
is imended to show the strength of The Society 
at the present time, our editorial team looks 
forward to receiving images produced since 
January 2007. 
ft is hoped that the submissions will show an 
even wider diversity of approach, from all areas 
of photography: art, journalism, commercial, 
technical, science and industrial, and from both 
amateurs and professionals - even appropriately 
challenging images created on mobile phones! 
Those who have their images included in the 
Members' Gallery will receive a free copy of 
PORTFOLIO TWO in recognition of their 
contribution. No fee will be paid. 
PORTFOLIO TWO will be a high quality, hard 
bound book. in full colour, that members will be 
proud to own, a contemporary record of TI1e 
Society's activities, and a powerful incentive to 
others to join a society that is recognised 
worldwide. Published at about £30 plus p&p, 
PORTFOLIO TWO will be offered at a reduced 
price to those who commit to purchase pre­
publication which wi ll be in time for Christmas 
20 10 making it an ideal gift. 
See Journal or www.rps.org for submision of 
digital fil es on CD, slides or prints. 

DI Group Special Event 
A Day with Steve Caplin 

See back page and book your place now for 
this all ticket event 
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From Secretary Bob Pearson FRPS 
The Digital Imaging Group 

13th Annual General Meeting 
held at Smethwick Photographic Society 
Clubrooms I 030 Sunday 19 April 2009 

Introduction The Chairman, Clive Haynes, 
opened the meeting and welcomed the 57 
members present and thanked them for attending. 
Apologies were received from Members Rosemary 
Wilman, Margaret Collis and Anthony Healy. 
The Minutes of the Previous AGM held on 20th 
April 2008 were accepted as a true record. 
Adoption Proposed by Graham Whistler, 
Seconded by John Long. 
There were no Matters Arising. 
Chairman's Report Cl ive Haynes made the 
following points in his report. 
The Group is i11 e.xcel/e11t health and continues to 
attract 11ew members. ft remains the largest 
Special Interest Group within 1he RPS with 
around 10% of the total Society membership 
belo11gi11g to DIG. 
Also once again this year, 1 ask eve,yone to take 
time to think about thefi1ture of the Group - and 
whether or not it sti/1.fu(fils a specific fimction, 
where the Group should be goi11g and wha, its 
general aims and objectives should be. With most 
ph0tographers 110w using digital technology. what 
is the future.for the group and what can be u11ique 
abo111 it? 
The committee continues to work hard 011 beha(f 
of the membership, with 111a11y behind-the-scenes 
activities. Committee meetings, email exchanges, 
phone calls. telephone coi!lerence-calls. meetings 

SecretalJ' Bob Pearson ERPS, Clwirman Clive 
Haynes FRPS and Treasurer Elizabeth Resta/1 LRPS 
rea,~v for the AGM 

at RPS HQ. Fenton House and at other venues are 
all part and parcel of what goes m, beneath the 
swface. it 's rather like the proverbial swan, all 
appearing gracejit! and ejfonless bw with a lot of 
paddling going 011! Continued page 4 

Articles and Images for DIGIT 
Autumn and Winter 2009 

Copy Oates end August and November 
DIGIT relies on the contributions of members. So, 
when will you send me au article for DIGIT? 
Remember that everyone is learning and that all 
expe1i euce is valuabl.e. You don't need to be an 
expert writer - we'l l help you if necessary. We need 
How To articles with your favourite digital techniques 
a11d of course your brjlliaut images. We know you're 
out there so we look forward to hearing from you. 
Thank you._J~m "B«m!tl::j LRPS Editor 

Email: editor@digit.rps.org 
I Aldenholmc, Weybridge, Surrey KTl3 0JF, UK 

DATES FOR YOUR DIARIES 

YORKSHIRE 
1000 Sunday 5 July 2009 

Following the superb March event Creatively 
Digital with Gwen and Phil Chamock FRPS, 
the next meeting shou ld attract most members 
and visitors. Morning with Yorkshire's own 
Roger Walton LRPS on Digital Workjlow:Get 
Sorted wit/, Lightroom. Afternoon John Smith 
covers AV for Begi1111ers. 

1000 Sunday 27 September 2009 
Print Appreciation Morning where members 
present and discuss their work and afternoon 

Print Presentation: Double Exposure by Paula 
Davies FRPS and Guy Davies ARPS 

Tickets at £5 to DJ members, £6 otbers. 
Cheques to: RPS-Yorkshire DI Group. 

Meetings held at: 
Selby Community Centre, Scott Road 

Selby Y08 4BL Ample free car parking 
Robert Croft Regional Organiser: Tel: 01977 
685262 Email: Robert@robertcroft.wanadoo.co.uk 

www.ydig.co.uk 

THAMES VALLEY 
1000 Sunday 27 September 

Ray Spence FRPS on Alternative Digital 
Techniques. How to create digital versions of 
popular alternative photographic treatments. 
Ray runs workshops on creative and digital 
photography and is a prol ific exhibitor. His work 
has been shown extensively in the UK and 
abroad and is available as lim ited edition prints. 

1000 Sunday 25 October 
Famous for Five Minutes 

... or ten or .fifteen! 
A chance fo r all to hold the attention of the 
meeting with perhaps prints or projected 
images, specia l techn iques, projects. new 
Photoshop plug-ins, or your work towards a 
distinction (RPS and others), or ... it's up to 
you! Take the tloor for 5 - 15 minutes. 

1000 Sunday 22 November 
AGM and Millennium Cup Competition 
See website for more detai ls: 

www .rpsdig-tha mesvalley .org.uk 

DIG/T is printed by Ian Allan Printing, Riverdene Business Park. Moisey Road. Hersham. Sun-ey KT12 4RG 
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Digital Imaging Grou 

DIGITAL 
REGIONAL 

ORGANISERS 
Contact the organisers listed 

below for full details 

Thames VaUey 
Roger Norton LRPS 

www.rpsdig-thamesvallcy.org.uk 
digro@rpsdig-thamesvalley.org.uk 

East Anglia 
Vacant 

East Midlands 
Bob Rowe ARPS 

www.rpsdigital-em.org.uk 
bob.rowel O@ntlworld.com 

Midlands 
Clive Haynes FRPS 

www.midig.org 
clive@crl1foto.co.uk 

North West 
Harry Bosworth 

harrybos@aol.co111 

Scotland 
Vacant 

Southern 
Dr Barry Senior HonFRPS 

barr;@littlepicsfreesrve.co.uk 

South Wales 
Maureen Albright ARPS 

www .southwales-dig.rps.org 
11ia11ree11@mauree11alb1ight.co1n 

Wessex 
Maureen Albright ARPS 

www.digwesseups.org 
mai1reen@mm1ree11albright.com 

Western 
Tony Poole ARPS 

to111Jiwle@hl11wnde1:co.uk 

Yorkshire 
Robert Croft LRPS 
www.ydig.co.uk 

robert@Jvbeltcrojl.wanadoo.co.uk 
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CHAIRMAN'S REPORT AGM 2009 
The group 's journal DIGIT is fantastic and goes 
from strength to strength. This high-quality 
joumal is only made possible by the tireless 
efforts of the Editor, Jim Buckley. However, Jim 
does not accomplish the entire task alone. The 
Group there.fore extends sincere thanks to Dr 
Da vid Cooke, who as Associate Editor, will take 
over lhe Editorship when Jim retiresji-o,n lzis post 
a, the end of this year. Indebtedness is also owed 
to tlze eagle-eyed proof readers Elizabeth Resta/1 
and Janet Haines. A ve1y big thank you goes to 
contributors without whom the whole endeavour 
simply wouldn 't be possible. Readers are ve1y 
impressed by DIGIT and the publication is 
frequent~y the prime reason f or j oining the DJ 
Group. 
Website The DI website has given cause f or 
concern over this past year. The site has been Lhe 
target of hackers. spammers and virns 
promulgators. T!Ie site needed to be closed and re­
opened, then of recent date closed again as more 
attacks were received. The DIG Forum is now a 
hidden sub-section within the main RPS website: 
this affords better levels ofprotection. Within the 
same area are the f acilities for members to 
comment 0 11 each other 's work, as in the old 
Folio, and take part in competitions if they wish. 
The DJ web~pages will also be an important 
section within the main RPS site. A new static web 
site is also in the planning stages j ust awaiting 
completion of a new RPS template structure to 
allow some aspects of the site to be interactive 
wi1h 1he 111ai11 RPS site. fl is hoped that this site 
will be operational in the near future. 
Management of the website. Fon1111 and Folio is 
far from simple and the committee is grateful to 
Maureen Albright f or the many hours she has 
expended on me,nbers • beha(l 
Maureen has been instrumental in defending the 
group ji·om the various a/lacks and has the latest 
news about web matters. 
John Long continues his role i11 much needed 
support f or tlze website, uploading information 
and bulletins and overseeing Fortun and Folio 
activity . 
£ -Group To communicate better with DJ 
members the committee is selling-up an e-Group. 
This is an email messaging service whereby the 
commillee can, .from time to time. send 
information to the membership: it is not a two-way 
exchange or discussion area. The DI Forwn will 
remain the proper place to raise matters and 
discuss news. 
Regions One .factor for the success of the DI 
Group is its regional structure. The Regional 
Groups and regional meetings are the very life 
and blood of continued good health. Good health 
can only be maintained with a healthy body and 
vital organs. The enthusiastic team of Digital 
imaging Group Regional Organisers - DIGROs 
for short - are the ve1y essence of this health and 
vigour. Without the willing enthusiasm of 

Members at t!,e AGM 

Ale.'!(' D11fiy supervises f/,e 

display ofpri11ts for t!,e 
selectors after the AGM 

Below: Gordon R11sl,ton 
and Gra!,am Whistler at 
work filming at the AGM 

DIGROs the group would decline. Once again we 
salute you all. 
There remains a need/or organisers and a team of 
people to establish the DJ Group 's presence in 
Scotland, East Anglia and the South East. 
Chris Haydon has been the committee link to the 
DJ Regions: however, because of health problems, 
Chris is unable to continue and is not seeking re-election. 

Exhibition The Annual Print Exhibition of 
Members· Work continues to be popular and 
appreciated at the various venues where it ·s 
presented. The touring Exhibition and the 
Exhibition DVD, mailed to all members with 
DIGIT, form a great platorm to publicise the DJ 
Group. Sincere thanks to Alex Dufty and his team 
of helpers. Alex is diligent, ensuring that ,he 
exhibition remains on track. For DVD production 
the Group remains indebted to Graham Whistler 
and his colleague Gordon Rushton .for video 
editing and production. 
Events Internal and External This year the 
Digital Group had a completely new venture. 
Maureen Albright masterminded an A V 
competitionfor youngs1ers. The RPS IRIS 25 as it 
is known attracted 79 entries from around the 
world and gained enthusiastic support. For four 
years Maureen and her Wessex DJ Group have 
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also been 
organising the 
UK leg of the 
J11ternatio11al 
321 AV 
co mpetilio11 , 
wo rking 
closely with ~_,....,. 

1na11y other photographic organisations ct!/ 
around the world. 
Tn April 2008 the group organised a Digital 
Portraiture and Digital Worl,.jlow weekend al 
West Dean College. West Sussex. Graham 
Whistler led the course, aided and abetted by me. 
/11 November the group was well represented at 
the Think Photo 08 Exhibition at the National 
Motorcycle Museum, adjacent 10 the NEC. The 
DI stand had many features to interest visitors 
and as Chairman of the DT Group T gave a talk 
about Digital Infrared Photography. 
In Janua,y this year, Graham Whistler and his 
w(fe, Wendy, led a DI Group inspired expedition 
to India. The trip was a great success and it 
further publicised aspects of the DT Group's 
activities. 
In Februmy we had a presence at the Focus 011 
T111agi11g Exhibition at the NEC when, as part of 
the RPS series of talks. 1 gave a short lecture. 
l ooking ahead to later 1his year. as part of the 
RPS. Real Thing series of events. the DT Group 
has engaged D1/Photoshop special-techniques 
and amazing manipulations specialist Steve 
Caplin to present an outs1C111ding day. The eve/II 
will 1101 only.feature a workshop lecture by Steve 
but also include his advice and ideas about 
images we submit as prints or electronically. The 
title is: Reality and 11/usion, the date is Sunday. 25 
October and the venue is The Old School House. 
Oldb111 y, West Midlands. The commillee is 
indebted to Jim Buckley for organising this much­
anticipated event.{See back cover/or bookingform/ 
All the above activity wouldn 't be possible without 
the unstinting e11th11sias111 of the commillee. 
Apart fi'om those already mentioned day-to-day 
activities are only made possible by key 1nembers. 
Bob Pearson as Group Secreta,y, deals with 
numerous queries and enquiries, liaises with the 
RPS HQ in Bath and keeps the committee on track. 
Elizabeth Re.stall as Group Treasurer maintains a 
close eye upon income and expenses and is ready 
to bring to the committee's attention any trends 
that look t11?/avourable. 
Tony Healy, in Australia. maintains contact bye­
mail and SJ,,ype contributing to the committee ·s 
wider appreciation o.f 111a11ers digital. 
Despi1e his ve,y demanding role as President of 
the Society, Bany Senior, Past Chairman of the 
Group, continues to 111ai111ain a close interest in 
the group activities. Bany is keen to respond to 
discussions and his input is always valuable. 
One final item T want tO bring to members' 
allenrio11 is the continuing attendance at RPS 
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TREASURER'S REPORT AGM 2009 
Web g uru Maureen 
Albright with her 
selec:red Exhibition print 

Treasurer Elizabet/, 
Resto/I dons tlte 111/tite 
gloves to display 
exhibititm s11h111issio11s 

Ac/vis01J1 Board meetings by John long and Jim 
Buckley. John is the DT Group Representative and 
Ji111 Buckley c1tfends as one of the six 
Representatives elected by RPS members. 1 thank 
them for this duty. serving as it does to maintain 
the Group's close contact wi1h the heart of the 
RPS. 
Regreuably. because of health problems. two 
commi11ee members are not seeking re-election. 
Thanks to Chris Haydon and Cesi Jennings .for 
co11tributi11g to the well-being and stability of the 
Group throughout this past year. 
Despite the fact that the Digital Imaging Group 
remains the most succes~/itl and also probab~v the 
most vigorous and the most wide~y represented 
Special Interest Group within the RPS, the 
following questions need to be asked: 
Does the Group continue to .fi1(fil a spec(/1c 
jimction? 
Where we should be going? 
What are our general aims and objectives? 
Whal is the.fiaurefor 0 111· Group and what can be 
unique about it? 
The Cbainnan ended his report by reminding 
members present that these were questions about 
which the committee would really appreciate their 
views later on in the meeting. 
Treasurer's Report 
Elizabeth Restall. DI Group Treasurer, drew 
members' attention to their copy of the Tncome 
and Expenditure Account for 2008, reporiing total 

income for the year of£ 11,554, of which £ I 0.108 
was derived from subscriptions. Total expenditure 
was £ I l ,207. of which £7, 133 was for the 
publication of DIGIT. The total cost of producing 
four editions of DIGIT was £3,500 less than for the 
previous year. This has been achieved by moving 
away from a small printer albeit with plenty of 
flexibility to a printer with more modern 
equipment. The first one to be tried disappointed 
on quali ty and a second change, with an excellent 
deal negotiated by Jim BuckJey with Ian Allan 
Printers who print the RPS Journal. ensured a 
saving of just over £600 on the Autumn and 
Winter editions. Best prices are achieved on 
multiples of sixteen pages and Ian Allan have 
special arrangements for posting bulk mailings 
that are not avai lable to smaller printers so we had 
saved several hundred pounds on postage for each 
edition. The Committee felt that these changes had 
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TREASURER'S 
INCOME AND EXPENDITURE 

INCOME EXPENDITURE 
Subscrip1ions £10,108 Co111n,i11ee Expenses £1,834 
ACM 2008 £ 812 AGM 2008/Exl,ibitions £ 865 
Bank /n1erest £ 221 4 lss11es of DIGIT £7.133 
VAT Rt!{1111d £ 412 Old Website (Zio111ech) £ 364 

Exhibition DVD £ 761 
D!Groups £ 250 

TOTALS £/l_,554 £11,107 
BALANCE SHEET 

2006 2007 2008 
8/F previous year £13,/08 £ 6.397 £ 3.422 
Income £13.822 £/2.589 £11.554 
Total £26,930 £/8.986 £14.975 
£xpendi111re £20,533 £15,564 £11,207 
Balance £ 6,397 £ 3.422 £ 3.769 
Balance made up of 
RPSAccou111 £ 6.935 £ 4.485 £ 5.481 
life Mem subs £ - £ 
Cash in hand £ - £ 
U11prese111ed cheques £ 53X £1,064 £ 1,713 
Totals £6,397 £3,422 £3,769 
Notes: 
/ 011 this occasion Commi11ee Expenses include 1ravelling. posmge. stationery, 1elephone 
calls and sundries. /11 2009 this expenditure will be broken down into separate headings. 
2 Subscrip1io11 revenue based 011 actual received - Dec 2007 to Nov 2008. 
3 Cost of printing DIGIT reduced by £3,500, compared ll'ilh 2007 figure. 

REGIONAL ACCOUNT ACTIVITY 
Wessex £3,829 
Yorkshire £ I ,340 
South West £ 136 

£3.208.89 
£ 1,397 
£ 55 

Thames Valley £ 1,456 £ 1,157 Fom1crly Ccnu-al Southern 
Midlands £2.677 £2,359 
East Midlands £ 520 £ 384 
Southern 
Scotland 
Wales 

n/a 
n/a 

n/a 
n/a 

Cash in Hand £230.96 
Rcponed Scottish RPS account 
Handled directly by RPS 

6llzabetl1 RUtaLL LR.PS 

Treasurer, Digital Imaging Group 

led to a significant improvement in cost reduction 
and, at the same time, increased quality. 
The Group's balance at the end of the year was 
much the same as last year, with only slightly less 
expenditure than income. The Regional Groups 
were a ll operating in the black. 
The group's participation in Think Photography 08 
incwTed expenditure of £409, mostly in travelling 
costs of members who looked after the stand over 
the two days. 
At last year's AGM the then Treasurer, Dr David 
Naylor, introduced an Income Plan and 
Expenditure Budget for 2008. The estimated 
income was £ 11 ,8 12 and the estimated expenditure 
£ 11 ,370. The group fell short of this income target 
by just £258 and achieved a modest u11derspend of 
£163. A similar plan bas been drawn up for 2009 
and this was set out on the reverse of the Budget 
paper. The increase in subscriptions from £ 12 to 
£ 15, agreed by last year's AGM, would ensure that 
four editions of DIGIT could be published annually 
in its current high quality format and the group 
could participate in events initiated by the RPS. 
Questions Arising At the end of the Treasurer's 
report, and in response to Elizabeth Restal l's 
invitation for questions for clarification, one 
question was raised regarding an expenditure item 
of £250 under the heading DI Groups and whether 

A/011 K11ight speol<i11g ot 
the AGM 011 the fi1t11re ef 
/he Group 

this amount was available to any DIG Regional 
Group. The Chainnan explained that the £250 was 
intended as a start-up grant for a newly formed DI 
Regional Group, such as Yorkshire who took 
advantage of the grant last year. It would be 
considered upon request, case by case. The 
intention is to allow a new group to get started by 
hiring a suitable venue, possible equipment and 
generating some publicity, etc. 
Adoption of the Accounts was proposed by 
Glenys Taylor and seconded by Roger No1ton and 
approved by a show hands. 
Election of Officers 
The following were proposed by Paula Davies and 
seconded by Dr Barry Senior and the Committee 
was elected en-block by a show of hands: 
Chainnan Clive Haynes 
Deputy Chainnan Graham Whistler 
Secretary General Bob Pearson 
Treasurer 
Members 

Elizabeth Restall 
Maureen Albright 
Alex Dufty 
Anthony Healy 
John Long 

Roger Norton and Dr David Cooke were nominated 
for the two vacant posts and their election, 
proposed by Graham Whistler and seconded by 
Guy Davies, was con finned by a show of hands. 
Any Other Business 
A request was made asking for clearer directions on 
how to reach the venue to be included in the AGM 
notice. For next year, more detaiJs would be given. 
Concern about the delay in setting up a new website 
was expressed. Maureen Albright explained the 
problems she had been having witb hackers. She 
had been working with the RPS which is 
developing templates. Dr Barry Senior said that the 
template faci lity will be available to all groups and 
regions and will provide all the facilities required. 
He a lso said that the RPS wishes to establish a 
stronger position on the web; it is currently getting 
hits of I 00,000 a month and the advertising 
potential from this was significant. The RPS 
Cou11cil is establishing a working party to keep the 
RPS website up-to-date. Another member 
questioned whether the template would allow 
Groups flexibility rather than constraining in the 
interests of confonnity. It was to provide a good 
image; also it was stressed there was no intention to 
restrict creativity. It would provide immunity from 
hacking, being professionally backed by OMNI and 
a special ist software security company. Dr Senior 
said there would be training awareness days for all 
SIGs and Regions at Bath as soon as the templates 
were available. The Chainnan ended this 
discussion by saying that the concerns bad been 
noted. 
Paula Davies proposed thanks to Maureen Albright 
for all her extra work. 
In answer to the Chainnan 's earlier request about 
the future of the Group (Sunset Clause), it was 
suggested that the group was about the better use of 
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digital technology independent of the subject and 
this was the reason it was such a strong group. It 
was proposed, therefore, that the DI Group 
continue (Nom1an Wiles, seconded by Andy Beel) 
and agreed by a show of hands. 
Graham Whistler confirmed that he was 
progressing with future arrangements for practical 
studio workshops. 
The Date and Time of the Next AGM would be 
Sunday 18 April 20 IO at Smethwick Photographic 
Society Club Rooms. The AGM closed at 1120. 
Tn the afternoon, Gavin Hoey gave a presentation 
called Confessions of a Photoshop Anorak which 
proved to be a very entertaining and informative 
afternoon. 
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,4bo,,e: Gm,i11 Hoe_,: fl 
selector f/111/ the 
qjier110011 ~-spe11ker. 
See www.gav1rai11.co111 
far Gfl111i1 ~1· tlllorials 
a11r/111ore 

left: Joh11 Lo11g ARPS 
prep11res the e11tries far 
11iewli1g with Elii11/Jeth 
Resto// LRPS 

Lejl: R.PS Presitle11t 
Or Bony.Senior Ho11 FRPS 
prese11l.f 11 Ribbo11 to 
Peter Heat/ LRPS 

Belo"' Lejl: Geq/j'Leo 
LRPS with hir Ri/Jbo11 
011tlpri111 

.ie/(Jw right: Alex 01'./JJ· 
lllPS watches f/S the 
Selecttll'J' 11,ke a d r,ser 
look. 

EXHIBITION SELECTION 2009 
Members' Print Exhibition 
I 07 members entered the Exhibition with 
selection before lunch so everyone was able to 
look at the prints as the selection was made. 
The Chaim1an 's Cup (given to the Group by BruTie 
Thomas FRPS and first awru·ded in 200 I) and 
Gold Medal were awarded to Brian Beaney FRPS 
for Retl Boat. Hi lary Robert 's two ribbons were 
awarded to Ray Grace ARPS for luflch is Served 
and Geoffrey lea LRPS for Fishiflg Cabins at 
Dawn. Gavin Hoey's two ribbons were awarded to 
Dr Ria Cooke LRPS for The Dyer 's Bicycle, 
Marrakec/1 and Peter Read LRPS for Heilli 
Bob Pearson's two ribbons were awarded to Peter 
Keverne ARPS for Pattems and Colours and 
David Eaves ARPS for Coloured Bacteria, 
Yellowsume. 

Abo,,e: The Selectors Covi11 Hoey, Bob Peor.fo11 
FR.PS 011tl Hilory /loberts FRPS see111 to be hovti,g 
flml 

AboPe: Chair11u111 Clive Ht{}'lll!S FRPS.1'/1(Jws r,if.jthe 
1111i1111i1g pni,t by .irifll1 Benlll'.}' FR PS 
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PROFESSOR BRIAN COOKE ARPS 

Steep Learning Curve to Associate 
Like many DI Group members Brian Cooke has had a life-long interest in photography 
but it wasn 't until he retired nine years ago that he had time to indulge himself and 
explore seriously this fascinating hobby. Getting the L was a first step along the 
distinctions road and here Brian encourages with his own story of perseverence to the 
goal of the A. You can see more of Brian's images at: www.briancookephotography.co.uk 

[joined my local club. the Harpenden Photographic 
Society, and soon got into the swing of 
competitions and learnt the mechanics of printing 
and mounting. I obtained my LRPS four years ago 
and foolishly thought that an ARPS would soon be 
achievable. I-low wrong I was. r submitted an 
APRS panel two years ago, attended the assessment 
at the Society head quarters in Bath and was very 
disappointed with my failure. Looking back l now 
realize that 1 wasn ' t ready aod that my panel was 
not up to standard. So how do you 'get up to 
standard'? 
I went through a process of trying many different 
subjects and fo1111u lating different panels including 
water abstracts, tree barks. seascapes and 
landscapes. But each time I either could not get 
enough images to make a panel of fifteen or 
reached the conclusion that they were not good 
enough. AJso it was very frustrating to learn when 
seeking advice that although some of the images I 
was producing were good the subject had been 
done many times before and therefore there was 
little point in continuing. 1 attended residential 
photographic workshops where you meet people 

Above: 
The successfitl A panel 
foyour 

Right: The barge 

with similar interests and obtain expert advice and 
guidance. T have been to severaJ organised by lain 
McGowan and have benefited a great deal from 
these. I also attended several RPS Distinctions 
Adviso1y days where expert advice is given by 
members of the Distinction Panels. Gradually I 
realised what was expected and by lots of practice I 
think I improved. I was told by a fellow club 
member that 'You wi ll know when you find the 
right subject'. 
One day I was out walking with one of my 
grandchi ldren along the canal path in Berkhamsted. 
when we came across an old rnsty barge. The 
owner had evidently begun to sand down the 
paintwork because in addition ro the rust many 
different coloured layers of old paint had been 
revealed. 
We stopped 
and J got very 
excited about 
the potential 
for a panel. I 
subsequen tl y 
returned and 
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started to take pictures. Unlike the many occasions 
after a shoot when you are disappointed when you 
look at the photos back home on the computer, I 
realised lhat there were possibilities in these rusty 
old barge images. 
I visited the boat four times. The kind of weather 
was important. lt had to be bright but not sunny or 
raining. Also it had to be a calm day otherwise the 
barge moved continuously against the side of the 
canal making sharp pictures very difficult. I used a 
hand held Canon EOS 5D SLR digital camera. 
images were taken at around 1/ I00lh second at fl0, 
ISO 400, using a 24-1 05mm Canon lens with image 
stabilization. 
As far as digital processing was concerned I used 
mainly Lightroom 2. As well as altering the 
exposure and using tone curves l found that the 
vibrance and clarity sliders added a lot of punch to 
the images. All the images were cropped to a square 
formal (20x20 cm). The final 15 images were 

chosen from about 300 images 
taken. Each image was 
approximately l: I with the 
original size of the image on the 
boat. 
The aim of the panel was to 
create a vibrant world of motion inhabited by 
fantasy figures and objects as well as displaying a 
pleasing balance of colours and tones. 
Choosing the images was a long process. l made 
I 2.5x 12.5 cm copies and kept them on my desk for 
weeks and each day I would shuffie them around. I 
really liked some of the images but rejected them 
because the subject and/or colour did not fit with 
the overall panel (see individual images). I 
eventually got down to about thirty. I made A4 
copies and a preliminary panel of fifteen in which 
subjects and colours were appropriately an-anged. l 
asked opinions from various friends and family 
including members ofmy own club where we have 
distinctions advisory sessions. I also took mounted 
images to a RPS Distinctions Advisory Day. Both 
Leigh Preston (a member of lhe ARPS panel) and 
Chris Palmer (a member of the LRPS panel) were 
very helpful. Comments and advice were given in 
front of the audience and later in one-10-onc 
discussions. 
The actua l 
assessment day 
was nerve 
racking 
particularly as 
mine was the 
last one before 
lunch to be 
assessed. The 
success rate 
was initially r.....;...J.___. 
about 10% 
which did not fill me with any confidence - the 
overall success rate for ARPS applications is about 
30%. There were four assessors plus the chairman. 
After the statement of intent is read out the 
assessors examine the panel which is followed by a 
secret yes/no vote. Each assessor then gives their 
opinion and there is then another vote. In the case 
of a tie the chai rman has the casting vote. 
Fortunately they were unanimous for my panel and 
I was successful. 
What now? Where do I go from here? There arc a 
lot of exciting possibilities and I really look forward 
to lots of experimentation. Hopefully one day I will 
once aga in know when lam onto something good. 
I found the follow ing links helpful: 
Distinctions anti Qualifications Criteria booklet: 
The Royal Photographic Society www.rps.org: 
Email: disti11ctio11s@1ps.org 
Saying it as it is. A very informative article on RPS 
distinctions by Michael Hallett FRPS. RPS Journal. 
Nov 2008. 476-479. 
Landscape Photographic Workshops la.i n 
McGowan FRPS Email: joy.iain@macace.net 
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DR DAVID F COOKE LRPS 

THE COOKE CHALLENGE 
This time we have four more images from DIG members who explain how they created 
them. I hope you ' ll find these interesting and helpful techniques to use in your own 
photography. If you do, why not join in and send me some of yours? Email me at: 
digitchallenge@gmail.com 

Figure I 

L«t !DIQ'l+lal 
• 1 .. 1 Plonetimpoo 

· :il Statn•ld l 
·l~ St¥fwldl 

• II Bo<kground 

Figure 2 

Battersea Tree by Jim Clark 

Planet Sydney by Tony 
Healy ARPS. 
After reading an article by 
Gavin Hoey in Digital 
Photography, about making 
your own planet I thought I 

would give it a try. It incorporates using the Polar 
Coordinates (Fi lter>Distort>Polar Coordinates) in 
Photoshop. My attitude is to try out exercises using the 
less familiar features in Photoshop to gain a better insight 
on how I might use them. 
It is easier if you start with an image that has a plain 
foreground as this will eventually become the centre of 
the "Planet " and masking the join is simpler. Also 
similar images and colours on either end will help too. 
The first step is to open the image and go to the Jmage 
Size and tum off Constrain Proportions and change the 
image dimensions to 4000 x 4000 pixels. Next rotate the 
image 180 degrees and go to Filter>Distort>Polar 
Coordinates, select Rectangular to Polar and press 
OK. These steps are seen in the first layers strip (Figure 
l ). You then need to clean up and/or clone the joins. I also 
rotated the image so that the Opera House was at the top. 
The next steps were not in the article. As an image of a 
planet it would have an atmosphere and surrounding it 
would be the blackness of space. l made a selection 
around the planet with the elliptical marquee, (holding 
down lhe shift key to get a circle) and feathered the 
selection by 200 pixels. Went to File>New and created a 
new file at 4000 pixels square and filled it with black, and 
used the Move Tool to drag the planet image onto the 
new black background. I have a couple ofstarfields in my 
files so I dragged a couple of them onto the new image 
making sme the layers were between the background and 
the planet layer. The second layer strip shows these layers 
(Figure 2). 

The shot was taken in Battersea Park on a du ll day last February. L had little conJidence 
that the walk in the park wou ld yield any worthwhile pictures, but after discarding the 
duds I managed to rescue three which made good prints. 

I treated the image as fo llows (using Photoshop CS3): 
I. A duplicate layer was made (Ctrl + "J") 
2. The duplicate layer was put out of focus with Gaussian 
blur (about 18 pixels) and decreased to an opacity of 
65%. 
3. The blend mode on this layer was set to Darken 
4. The two layers were flattened. 
5. The layer was desaturated completely to monochrome, 
useing a hue/saturation layer and the image was fl attened 
again 
6. The history brush was applied to the image, at an 
opacity of about 20% to bring back part of the colour 
original. 
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DR DAVID F COOKE LRPS 

The Enchanted Wood by John 4. Layer mask added and 100% black 
Wigmore FRPS. painted into it with a soft brush to reveal 
This image has had many exhibition lhe lower (sharp) part. Saved again as a 
acceptances together with a smattering of ncw.psd ti le. 
a ... vards. I had a preconceived idea as to 5. Opacity reduced to 80% to enable me 
what J wanted to do i.e. to produce an to sec the branches and leaves, and using 
image in a bluebel l wood with the a small brush at 80% hardness. some of 
foreground flowers sharp and the rest all the branches, twigs and leaves were 
motion blurred on a vertical axis but with revealed sharply by painting I 00% black 
one branch of a tree (with its leaves) all into the layer mask. This took about 4 
sharp. hours until I was satisfied! I made several 
The tricky bit was to find a suitable tree in saves during the process in case of a 
our local bluebell woods on a fine day! power failure or simply boredom! 
Having found the tree I took several raw 6. (See screen grab of layers palette). A 
files and selected the one with the least levels adjustment layer was added, linked 
wind movement of the leaves. Photoshop to the motion blur layer so this layer 
CS3 was then used as follows in a PC: could be lightened/darkened as 
I. Raw file converted in ACR and saved. necessary. The final work was again 
2. In Hue/Saruration, the yellows were saved with layers in case it needed 
hued +6 to improve the leaf colour, modification later! 
unsharp mask applied and saved as a new 7. Final ly. the opacity was returned to 
file. 100%, the layers flanened, overa ll levels 
3. Background layer duplicated (Ctr! + applied and the final image saved with 
"J"), to which motion blur at 90° was duplicates to external hard drives. 
applied at about 400. Top cropped a little The beauty of using a layer masking is 
and file saved as .psd including the layers. that it is non-destructive and any mistakes 

Swinging Along by John Long ARPS. 
In recent months, a new Shopping Mall 

has opened in Bristol called Cabot 
Circus, and on my first visit I noted that 
the frontage of some of the unoccupied 
shop units had large colourful mura ls in 
place. I on ly had rny little Canon 
Compact with me. but I decided to 
photograph a number of passers-by in 
front of one particu lar mural. None of 
ihem were successful, so I resorted to a 
photograph J took in Amsterdam last 
year of a Nun passing a rather colourful 
shopfront. 
You will see that there was a traffic 
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bollard in front of her. so I needed to --rebui ld" 
her dress and her right leg and foot. (She 
wasn't harmed in the process of this 
operation!) It was then a maner of extracting 
her and asking her to 
kindly walk into my 

picture, taken in Bristol! 

Branches and twigs revealed 

r Normal 3 Opacity: 
1 80% ~ 

Lock: 0 J + Ii RO: ~ 

,~ • ~ tiD levels I 

~ - ~ ~ Mellon Sha• 

~ Ill B•cl<ground 

Screen grab of layers palette 
are easily reversed by painting with 
white. This was done many times 
during the making of this image! 
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DR DAVID F COOKE LRPS ----------------------------------
WEBWISE 5 with David Cooke LRPS 

All the Webwise material is on the new DI Group Forum which is located within the main RPS 
Forum. You'll need to register to make comments and to contribute. Details of how to do this are on 
the main RPS DI group page at http://www.rps.org/group/Digital-lmaging. Please do make a 
comment on the Forum or email me at digitwehwise@gmail. com to let me know how useful (or not) 
you found the sites recommended. And please do recommend sites you've found interesting yourself 
so other members can share them. 

Welcome to the fifth edition of Webwise. This time I've 
got recommendations for a podcast, two interesting 
photographers and a website. 

Lenswork Podcasts 
http://www.lenswork.com/lwpod.htm 
or subscribe on iTunes. 
These podcasts are by Brooks Jensen who is the editor 
of Lenswork, a US fine art photography magazine. The 
Lcnswork website says "lhese commentaries range 
across an eclectic landscape of topics from fine a1t 
photography to fam ily snapshots, from h·aditional 
images to the digital revolution. Sometimes an 
irreverent look at the state of photography today, 
sometimes sarcastic, occasionally off-topic, but always 
inspirational and practical." 
Each podcast is nonnally five to ten minutes long and. 
as they are audio podcasts, they can be listened to on 
Lhe move using an rnp3 player. 
They started in February 2004 and are issued several 
time a week, so there are now over 500 of them. f find 
them interesting and thought provoking so do listen to 
a few of them and, if you like them you can down load 
all 500 of them as zip fi les at: 
http ://www. le nswork .com / le nswo rkpodcast 1-
3.htm#Z I PPED collections 

The New 100 Prints Project 
Brooks Jensen also has his own site (Brooks Jensen 
Arts) where you'll find an interesting 'Newl0O Prints 
Project". Go to 
http://www.brooksjensenarts.com/ 
then click on 'The New I 00 Prints Project' link. 
The plan is to post a new image every three days for a 
year. There are some very interestjng images, each of 
\.Vhich is accompanied by an audio commentary (right 
click on the audio commentary link and select 'open 
link in new window' to make sure you can still see the 

Poolside by Phil Drake FPRS 
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image). It's well worth a look and I hope you'l l find it 
inspi1i11g. 

Digital photography school 
http://digital-photograpby-school.com/ 
The Digital Photography School is a website dedicated 
to tips and tutorials on photography, cameras and 
equipment, and post production. Each of these topics is 
listed on the home page and each catego1y is fu1ther 
divided into recent. popu lar and featured items so it's 
easy to find interesti ng things quickly. You can also 
search for topics of interest to you. 
Each item is an article, rather than being a podcast or 
video. so you can read them on li ne or down load them 
using the 'Save page as' feature of your browser to read 
later. 
It's a website with simple tips to help digital camera 
owners get the most out of their cameras and it's aimed 
at the new to semi experienced digital camera owner. 
There are many other featu res to the site, including a 
forum, and it's a good resource. I'd recommended that 
you spend some time exploring it. 

Phil Drake FRPS 
http://www.phildrakephotography.eo.uk/ 
Phi l Drake FRPS is a member of the DI group and his 
website has some really interesting images which are 
well worth investigating 
As explained on the site, his early photography 
concentrated on the rural landscape and was 
exclusively B&W, all taken with film but, in the last 
eight years he has been exploring the urban landscape 
and has endeavoured to show, in his Black and White 
pictures, graphic images that concentrate on ordinary 
subjects to be found in the streets of our modem cities. 
The pictures have geometric shapes with curves. 
straight lines, angles and, in most cases. strong 
shadows have been included to make up the fina l 
composition. 
Although B&W is his first love he does now take 
colour as well and there is a section showing this work. 
He has had prints accepted for International and 
National exh ibitions 

An invitation 
If you'd like your website to be featured in future 
Webwise articles then please email me at 
digitwebwise@gmail.com with details of your site and 
let me have a few words about your photography. It 
could help to put you in touch with like minded 
photographers. 
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TONY HEALY ARPS 

INFRARED - A NEW VISION 
PHOTOGRAPHING THE 

INVISIBLE 
Former Kodak staffer Tony Healy from Australia, DI Group committee member and 
regular contributor to DIGIT, continues our series on infrared photography in 
preparation for next year's celebration of the centenary of the first publication of IR in 
The Journal. Along with his own images he uses some from Steve Ridgway LRPS to 
discuss traditional mm IR and pseudo IR using digital imaging. 

RPS DIGIT Magazine Summer 2009 

A
s a brief definition. the 
electromagnetic spectrum 
is a band of radiant energy 

ranging from wave lengths 
smaller than an atom. to those that 
are ki lometres long. Within this 
vast range there are pai1s that are 
used beneficially by humans: 
Xrays, microwaves, ultravio let 
waves for sterilisation, radio, 
radar, TV etc. The one common 
bond of all these uses is that 
special devices are needed to 
interpret or view the results of 
their use. However, for humans 
there is one small window in the 
band which does not require 
anything e lse to detect the 
radiation but our eyes. Our sight 
enables us to take the wave 
lengths between 380 nanometres 
and 750 nanometres and produce 
images of our world ranging in 
colour from deep violet to red. 
Shorter than 380 nm is the 
ultraviolet which insects and 
some birds can perceive and 
above 700 nm lies the infrared and 
heat wavelengths. The fact that 
we see a red object is brought 
about by the object absorbing all 
wavelengths of radiation except 
those that produce a red sensation 
in our brain. A similar process 
goes for all other coloured objects 
but there are some limitations to 
our vision . When we look at green 
plants, in general, we see an 
object of relatively low 
brightness, but research has 
shown that there is much more to 
green plants than we can see. 
Ch lorophyll, the chem ical that 
gives plants their visible green 
colour, is a highly efficient 
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TONY HEALY ARPS 
reflector of what we can't see: infrared radiation. 
In order to 'see' this radiation we have to resort 
once again to a detection device and in the initial 
years of research this was film emulsions. 
During the sixties infrared photography came into 
prominence mainly by it being used for 
camounage detection. Jt appears that while 
chlorophyll is an efficient reflector of [R radiation. 
green paint or green dyed textiles are not. In order 
to capitalise on this feature the Eastman Kodak 
Company produced a film cal led Kodak 
Ektachrome Infrared Aero fi lm for mi litary use. 
The emulsion was constructed in such a way as to 
produce a bright red colour for green plants and a 
dark blue colour fo r non-plant greens. As all 
photographic emulsions are sensitive to UV 
radiation this film had to be used with a yellow 
filter to stop UV and blue light from exposing all 
the layers. A later 35mm version was produced 
called Kodak Infrared film (False colour fi lm). 
There were monochromatic emulsions available at 
the time and they restricted the VY and blue 
radiation by using a red or deep red filter during 
exposure. 
With advances in technology we now have photo­
sensors that will record IR images without the 
need of film and this has brought about a renewed 
interest in IR photography. Digital photography 

.. I.._ 'f 

.. .,, .. 114 
• 

has also allowed the production of pseudo infrared 
images but careful analysis shows they do lack 
some of the characteristics of true IR images. 
The four images a, b, c and d illustrating [Ron the 
previous page were all taken on the same day. 
However, during the process of changing cameras 
and setting up the same, or near same, 
composit ion clouds arrived on the horizon and 
shadows changed in the foreground. The four 
images arc: 
a. Kodak Kodachrome film; 
b. Kodak Infrared Film (false colour) 
c. Kodak Infrared B&W lilm and 
d. a pseudo IR image produced from the Kodak 
Kodachrome slide. 
The most notable difference is in the sky. Where 
air pollution exists on the horizon pseudo IR 
pictures can enhance this due 10 the lack of blue 
light in this region of the sky. The difference in 
brickwork rendition is also noticeable. 
It was possible to create some variation with the 
False Color Film by using different filters over the 
lens. Pictures e, f and g show a wal I of ivy and the 
variations that cou ld be capt11red; pictures h.i and 
j show the variation in sky colour using the same 
filters as the ivy. 
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TONY HEALY ARPS with STEVE RIDGWAY LRPS 

It should be noted that with the ability to control 
Channels in digital photography one can emu late 
the False Color Film appearance and indeed an 
extension of this is used today in remote sensing 
by satellite LO bring out different features of the 
Earth ·s landscape. In this instance seven spectral 
bands are used ranging from the Ultraviolet to the 
far Infrared portions of the spectrum. 
1t is possible for you to produce your own False 
Color image using these techn iques. The 
following steps are by courtesy of DIG member 
Steve Ridgway LRPS. 
You need both a normal shot and an infrared shot 
of the same subject and to be able to align them. 
l . Create a new document (image) with the same 
width and height in pixels as the lR and RGB 
images; 
2. Go to the RGB image. and select the Channels 
palette; 
3. From the Channels drop down menu select the 
option to split the RGB channels. You wi ll end up 
with three new images. One wi ll have R in the 
ti tle, one with have G. and the other wi ll have B. 
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4. Go to the R image (the red channel) and copy 
the image (Select>AII, Edit>Copy); 
5. Go to the new blank image and select the 
Channels pa lette. Click on the Green channel to 
make it active then paste the copied R image into 
the Green channel: 
6. Go to the G image (the green channel) and copy 
the image (Select>AII. Edit>Copy); 
7. Go to the new blank image and click on the 
Blue channel to make it active, then paste the 
copied G image into the Blue channel ; 
8. Go to the IR image and copy the whole image 
(Select>AII. Edit>Copy); 
9. Go to the new blank image and click on the Red 
channel to make it active, then paste the copied IR 
image into the Red channel; 
10. Cl ick on the RGB Channels palette to see the 
final result. 
Basically this is how the channels get re-mapped : 
RGB Red > New Green 
RGB Green > New Blue 
IR (Grayscale) > New Red. 
Images I. 2 and 3 show Nonna!, Infrared and final 
composite. 
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JANET HAINES LRPS 

CREATE YOUR OWN HOME 
ART GALLERY 

"Do your images stay in your PC unseen and unappreciated by your family and 
friends?", asks Janet Haines. If so, why not create your own home art gallery? Here 
she explains how. 

Landing gulle1J1 - Mike'.\· memory images 

We all spend hours creating our masterpieces and 
other than perhaps printing one or two for the 
occasiona l club competition we keep them 
squ iJTeled away in folders, more than likely 
duplicated or triplicated for safety. J am sure my 
story is the same as many of us but my husband 
decided my art needed to be appreciated and 
wanted to create a gallery in our home. Perhaps I 
should have been flattered but the fact of U1e 
matter is 1 like plain blank walls and would have 
my house more minimalist U1en be. So to decorate 
it with rows of pictures wasn't quite what I wanted 
to do. And in any case I wasn't too sure l wanted 
my photos on show. That was more to do with not 
wishing to put my visitors on the spot of ' having 
to' admire and view my work - what if they think 
my work is rubbish. Would my fragi le 
photographic self confidence survive? But hubby 
forged ahead with his vision, taking me along as a 
reluctant contributor. 
Now l do adm it Mike has a good eye for things 
and is certainly a perfectionist when it comes lo 
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Lounge - a single run of architectural images 

anything DJY. "lf a job ·s worth doing, it is worth 
doing well" is always his motto. His vision was to 
see them hung in a very modern way, preferably 
on the fine stainless wires a la up-market Estate 
Agents windows. So he did masses of research on 
U,e web. To start with the costs seemed rather 
high, but his persistence paid off and he found the 
supplier we would eventually buy from. 
First there was the planning. Agreement No 1 was 
just how many walls and which rooms we would 
'wire up'. Less for me - more for him of course. 
He won! We would have some single runs on 
strategic walls and some multi displays on other 
larger areas. Deciding the spacing was difficult 
but we finally settled on pictures being 30 x 40 
cm, borderless mounted on the modem foam 
board. The wi res were bought and duly arrived. 
They come as kits but are honestly very simple to 
put together. Walls were marked, drilled and 
fixings fixed. All very precisely so that wires 
were 100% vertical, the coJTect distance from one 
another and tensioned appropriately. Now it was 
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my job to prepare the images. 
To start with 1 just raided my old box of c lub 
competition prints. These were ones I had used 
for my LRPS mainly, so at least they had matching 
c ream mounts. But ideally Mike wanted newer 
images on the preferred foam borderless card. So 
to start with we had the different styles in different 
rooms. The next challenge was how to keep them 
attached invisibly to the stainless wires. 
Not wanting to use the rather bulky fixings from 
the supplier Mike got inventive. On the rear of 
each board, one in each comer, we stick a self 

Fixing - shows the chrome anti stainless steel wall 
fixings. 

adhesive electrical wire cleat; the sort you buy 
from electrical wholesalers to keep cables tidy. 
These have four slots in them through which we 
passed a small fine zip tie. The board is then 
offered up to the wires and fastened round them, 
pulling them tight enough to hold the weight of 
the board but still allowing you to s lide them up 
and down the wi res for an-anging. 
The final display is a ll very neat and professional 
looking. At any time we can easily snip off the zip 
ties and replace the images. After lots of 
experimentation with which glue to use to stick 
the prints to the foam board believe it or not I find 
the best is good o ld Prit Stick. l give the rear of 
the print an all over stick, paying extra attention to 
edges and corners. The print is then stuck to the 
pre-prepared foam board (30x40cm). I use a clean 
piece of paper over the front of the print and my 
trnsty lino printing roller to ensure there are no 
bubbles (a problem I had with some glues). The 
additional benefit of using Prit is that when we 
decide to change our images the prints come off 
pretty easily and the boards can be re-used most 
ti mes. 
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Rear fixing - shows the cleal5 and zip ties 

My home gallery is admired by most visitors and 
the up side to that is that it has increased my own 
photographic self esteem. We now both enjoy 
haviug some of my work on the walls and to be 
fair we take it in turns to decide what images go 
up where. Mike likes memory shots whereas I go 
for my more architectural ones. l would 
commend the idea to you - it is fun to have some 
of your photo-art up on the walls and out of their 
computer folders. 

H1111g 011 wires - shows the wires aud wall fixings 

Note: The web site for sourcing the wires used in 
this display is www.shopfittingwarehousc.co.uk 
then go to the li11k for Estate Agent Displays. 
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BRIAN REANEY FRPS 

THOUGHTS ON MY 
PHOTOGRAPHY 

Brian Beaney won the this year's Gold Medal and Chairman's cup for his image 'A 
Red Boat'. In this article he explains his approach to his photogprahy with the help of 
both the oringinal and final images. You can see 'A Red Boat' and comments on it on 
page 22. 

Eile,m Do11a11 Castle 

Eilenn Do11((11 Castle origi11al 

Putting pen to paper to write this article 
is as difficult for me as putting brush to a 
blank canvas - it always Lakes days to 
get started. There is something about a 
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blank sheet that acts as a barrier Lo 
creativity: bul with Photography 1 don't 
have that problem. because I am already 
half way there. 
Yes l know we have to take the pictures 
in the first place, but somehow it's easier 
to get started. All we have to do is select 
the mo t exciting images to work with 
and start the process with a little 
imagination. and the help from 
Photoshop. I tend to work in groups of 
four or five, mostly of the same subject, 
but before I do any pre-correction I run 
the technique forward on a few images to 
see the potential and whether it tTiggers 
the imagination or not. It's exciting 

sometimes when an image almost 
dictates the creative journey. The style is 
the same but the approach is different. 
So many times the mood changes when 
I might impo11 a cloud or add a mist 
effect. Unfortunately it quite often has 
the opposite effect and. I ike over 
working a painting, ends in the trash bin. 
I do envy "conceptual'" photographers, 
they create an idea then search and bring 
the clements together. Whenever I've 
h·ied this approach I'm faced with the 
blank canvas syndrome again. Even if I 
get a spark of originality it always ends 
up in the trash can. So how do l find 
my pictures, well I don't ! they find me. 
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Old Farm Machine 

I believe in fate. Instinct r'm sure plays a 
big part in guiding me towards the 
pictorial subjects that give me a 'buzz'. 
I take about two to three hundred 
pictures a year, which is very small 
compared to others, and I will make a 
selection of about 30 and finish with 
about 20 new pictures a year if I'm 
lucky. l average about 20 hours in order 
to complete a picture. 
Apart from looking for good pictorial 
subjects, I am always looking out for 
interesting foreground material and odd 
elements, you never know when they 
might be useful in developing an image. 
I also collect cloud fonnations, sunrises, 
sunsets and high wispy clouds to 
thunder clouds. lt is also important to 
take clouds from different angles from 
the sun. from the left, right. behind and 
into the sun. It is essential to match the 
sky with the shot. 
Eilean Donan Castle: For example the 
picture of Ei lian Donan Castle shows an 
imported sky. tbe size was wider than the 
image size as this allows me to move the 
clouds around to aid composition. The 

lost and lonely original 
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foreground was also imported because I 
wanted to show what this wonderful 
castle might have looked like in days 
gone by. I also needed to move the 
castle over to the right. This was 
achieved by making a select ion of 
approximately one fifth in from the left 
hand edge and stretching it out using the 
transfom1 tool and then repeating the 
action the other end but this time 
reducing it. The canvas size was of 
course changed lo fit the new format. 
Old Farm Machine: l came across this 
'old farm machine' on a park in Walnut 
Creek, Cali fornia. Apart from a record 
shot there's not much else you can do 
with it but, because it's so interesting. I 
imported it to a shot of nowering thistles 

lost and lonely 

~· ·• 11~ Jj,,,'i! 

J 
... , .. .,. . ' I~ 

-I rJ, 

·: · A . 

Old Farm Machine original 

r took the other side of the park to give it 
that abandoned look. I simply blended 
one layer into the other and lhcn worked 
it through my normal technique. 
Lost and Lonely: sta11ed off as a shot 

ofa Scottish loch. Good landscape but it 
needed some strong i11teresl to enhance 
the composition. Earlier in the week I'd 
found a herd of Highland Cattle which 
needed a good landscape so I borrowed 
a cow and dropped it into the picture. 
As I developed the image 1 realised that 
the tan coloLLr of the cow was too strong 
for the gentle tones of the loch. At this 
point "Monarch of the Glen•· came to 
mind so 1 decided to convert it to 
monochrome, add some noise, and a 
little saturation. The result gave il an old 
etching quality which I think uits the 
image better. So once again for me the 
pictme has dictated the creative journey. 
( This image is a medal winner at The 
London Salon of Photography 2009 
Ex.bibition.) 
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BRIAN HEANEY FRPS 

Carol A1111 & Esme 

Carol A1111 & Esme original 
Carol Ann & Esme: Boats and harbours are 
always a big attraction to me. They have a natmal 
atmosphere which never fails to excite me, 
especially the ones local to me. You can feel the 
history which goes back to the Saxons and 
evidence can be seen at the Sutton Hoo 
Exhibition. This shot was taken early evening at 
the Barge Harbour, Woodbridge. As can be seen 
the background is intrnsive and needs to be 
blurred slightly, and some mist added. The sky 
was lovely and just required a little enhancing. 
The foreground was a delight to work by 
modelling the wet mud with light and shade with 
adjustment layers of curves. Finally, I applied a 
wa11n up filter just to increase the mood. 
Fantasy Creatures: Last aun11nn [ was walking 
with the grandchildren through a wooded park and 
for some reason, instinct again! maybe, but l 
walked off track when something caught my eye. 
It was a well weathered tree stump. It was just 
catching the early light through the trees. My 
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imagination went into overdrive, I saw these fantasy creatures sculptured by 
nature. I took several shots a ll round the stump and at different angles. From 
these I produced 6 images, 4 of which made an interesting panel. The 
background was cut out and another shot of the stump was imported in. The 
modelling of the faces was enhanced using curves light and dark, then 
finished with retouching layers to bring out U1e fantasy images. 
1 spent the rest of that morning searching the woods fo r similar subjects, but 
nothing came any where near to stimulate my imagination. It 's fate! so ot1en 
J go for months before I find that special subject. 

Original im{lges t{lke11 of(/ single tree stump which 
were used to m{lke the Fa11t{ISy Cre{ltures 

Aga111e11111011 

D{lvros Taurus 
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BRIAN BEANEY FRPS 

Aga111e11111011 Cerberus 

Dm•ros Taurus 
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PRINT EXHIBITION 2009 GOLD MEDAL AND CHAIRMAN'S CUP WINNER 

A RED BOAT 
Brian Beaney FRPS 

Gavin Hoey: Anyone who thinks photography isn·t 
an expressive art fonn hould look closely at this 
picmre. The gentle muted colours are beautifully 
complemented by the splash of red on the boat. but il 
was the strnngely distorted shapes in the background 
that really caught my eye. To me the whole picture had 
the feel of a Turner painting. not completely abstract 
but far from real. Looking at the picture makes me feel 
ca lm. relaxed and jealous. Why jealous? Well this 
picrure has the most impo1iant winning factor ... l wish 
I'd made it! 
Bob Pearson FRPS: This image immediately stood 
out. The tonal balance is excellent with the brightest 
red being optimally placed in the image and 
surrounded by complementa1y colour. The mist 
reduces distractions and adds atmosphere. 
Hilary Roberts FRPS: An absolutely stunning image 
- so subt le. but with just enough information. 
Beautiful, soft. gentle. understated colours, and just 
the right amount and shade of red to make the foca l 
point of the boat hit you between the eyes. I have no 
idea what the background is. but looking at it now it 
does look rather like Geoff Lea·s fish ing cabins. 
Perhaps it was some sort of simi lar constrnction. I 
think this was the on ly image in the whole entry on 
which we three selectors were immediately and 
unanimously agreed the minute it was put up 
before us. Well done Brian (again!) 
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Brian Seaney FRPS: One of the joys of Photoshop is 
being able to .--------------~ 
go back in 
history and 
take another 
route - which 
was the case 
of the ·Red 
Boat'. It 
started off as 
a back up 
picture for my F panel but didn't make the final 
selection so it spent a couple of years in · Room IO I'. 
especially as it had two rejections from Exhibitions. l 
would like to say that the inspiration to carry it 
fo rward came whi le browsing through a book of 
William Turner, but sadly it clidn·1. Although there is 
a vague similarity, it didn't dawn on me that it had a 
'Turner" feel to it until it was finished. I was simply 
playing around with textured and blurred layers. 
cloning edges and pushing pixels around, and there it 
was 21 layers later, another technique born out of 
boredom. You see I had caught up with all the new 
work and it had been raining for days. Sometimes the 
gloomy days of winter can be the most creative. I often 
spend time going back through older files just in case 
l"ve missed something or for images that can now be 
used with an improved technique. 
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RIBBON WINNER. JUDGE: GAVIN HOEY 

THE DYER'S BICYCLE 
MARRAKECH 

Dr Ria Mishaal Cooke LRPS 

Gavin Hoey: An old bike, a splash of red, only a 
pbotographer could have seen the potential in this 
image. I suspect many of us would have taken the 
straight image and been very happy with 
the result. 1-lere's where this photographer has 
really excelled because they've taken a nice 
picture and elevated it into the realms of 
something specia l. For me the composition. colour 
and enhanced tone and texture made the image 
one I could look at again and again. 
Dr Ria Mishaal Cooke LRPS: This finished 
image captures my perception of the essence of 
Man-akesh. The manipulations l applied to the 
original captured image were a means to this end. 
This ·street stil l life' was as depicted deep in the 
Souks oftbe city: I was struck by the vibrancy and 
complexity of the colours in the wall and the wool, 
and the interplay of light and shapes, as we passed 
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the scene in what was a small break in the 
thousands of laden shops, which are a more 
common subject for phot0graphs of this city. To 
capture the image as T saw it, I took 3 images. 2 
stops apart, to create a high dynamic range (HDR) 
image which gave me the deta il and depth I was 
looking for. A smal l amount of cloning was 
applied to the cobbled street to remove some 
distracting objects (a plastic bag!). To relate how I 

experienced the souks I wanted to add some 
emotion to the image by enhancing the textures 
and emphasising the lighting, and l did this with 
careful and restrained brushing in of level 
adjushnents and a couple ofmy favourite til ters in 
Colour Efex Pro (Nik Software plug-in for Adobe 
Photoshop). I hope that the image conjures up the 
beauty. drama. and yet the peace within chaos that 
this city has for me. 
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RIBBON WINNER. JUDGE: GAVIN HOEY 

HEIDI 
Peter Read LRPS 

Gavin Hoey: As a enthusiastic 
user of the digital infrared 
technique l was tbri lled to 
see several infrared photos entered 
from several photographers. This 
picture stood out for me. The 
infrared technique has worked its 
usual magic on the foliage and 
created a dramatic sky, but then 
there 's the composition. l' m 
always looking out for symmetry 
in my own photography, so this 
picture really appealed. I enjoyed 
the converging track lines and the 
mi1Tored bush but inclusion of the 
dog was the icing on the cake. 
Peter Read LRPS: This image 

was taken in infra red using a Sony 
F828 camera with a 920nm very 
dark red filter. I took the 
photograph whilst on a Salisbury 
camera club summer walk. Lt was 
taken in mid summer on a farm 
belonging to the owner of Heidi 
the dog. The field has been set­
aside land for some years and 
allowed to grow wild. So there is 
quite a bit of scrub now. However, 
there are many orchids too. The 
fann is near SalisbLtry on chalk 
downland situated on a ridge. So 
the view beyond the dog is over 
the southern landscape of 
Wiltshire. 
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RIBBON WINNER. JUDGE: BOB PEARSON FRPS 

COLOURED BACTERIA, 
YELLOWSTONE 

Bob Pearson FRPS: A successful image from 
this popular location. ll gives lhe appearance of 
being taken with a wide angle lens from a 
relatively low view point, this enhances the sweep 
into the image along the edge of the geyser. This 
strong line is enhanced by its strong colour 
contrast and by the decreasing contrast towards 
the edges of the image due to the steam. 
David Eaves ARPS: This image was taken in 
2007 during a visit to Yellowstone, specifically 
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David Eaves ARPS 

Grand Prismatic I-lot Spring. It is impossible to get 
the whole of this hot spring in an image without 
taking to the air so l tried to get a feel for the 
colours, the texture and tbe sinuosity of a small 
detail, ie. the orange band of bacteria. with a 
background of steam and vapour. As I remember, 
I used a very wide angle lens ( I 0mm) to 
emphasise the orange band. The whole area brings 
to mind Dante's hell and an alternative title is 
' Into the Inferno'. 
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RIBBON WINNER. JUDGE: BOB PEARSON FRPS 

NO 3 PATTERNS AND 
COLOURS 

Peter Keverne ARPS 

Bob Pearson FRPS: Although giving 
the intriguing impression of a door let 
into a wood pai ling wall the treatment 
used has reduced reality into simply 
'No 3 Patterns and Colours'. The 
colour tones arc well balanced and the 
pattern adds mystery. 
Peter Keverne ARPS: The oiigina l 
picture shown above was shot at the 
Geevor Mine Museum, West Penwith, 
Cornwa ll a couple of years ago when 
the site was under refurbishment. I wa 
struck at the time by the mixture of 
wood and the rusting ta1Ted corrugated 

cladding. l used the picture in an NV 
about Rust but it was not until l 
discovered the Redfield Fractalius 
Software that l thought this picture 
was worthy of further consideration 
and experimentation . The picture was 
cropped. ln Fractalius I looked at the 
effects of the different presets but in 
the end sett led wi th the Rounded 
Preset. The sliders were adjusted to 
give a more subtle effect. The image 
was taken back into Photoshop and 
tweaked in Levels to give the final 
effect. 
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LUNCH IS SERVED 

Hilary Roberts FRPS: I picked this one for a 
ribbon because it is a very common subject treated 
in a completely different way. Everyone loves 
puffins. and the usual "Puffin with Sand Eels" 
shot is often seen in nature sections. ([ take these 
are sand eels? l am not very up on fish. even 
though my t\vo ribbon winners share a fishy 
connection). This is the same subject, but not a 
"nat11re'· picture at all. You can't see its feel, there 
is no light in the eye and the title would make 
nature judges groan. 1 really like the way the 
image has been desaturated and blurred. while the 
face is kept pin sharp. and the title fits the image 
perfectly. I love it! 
Ray Grace ARPS: This photograph was taken on 
the Fame Islands last year. Nature photography is 
something I have grown into over the last couple 
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Ray Grace ARPS 

of years, although l 've been a casua l bird watcher 
for a good number of years. Perhaps l tried to run 
before r could wa lk properly as I did try 
photographing Puffins in flight (as well as other 
birds) but found quite quickly that Puffins fly like 
bullets. Photographing them on the ground was 
much easier. Some larger bi rds proved less 
frustrating but flight photography proved to be 
extremely difficult. although T persevered for a 
good few hours. One or t\Vo in-flight pictures did 
work but I thought this image of the Puffin just as 
it hit the ground was my most successfu l, 
particularly as I intentionally tried for a low level 
shot with an out-of-focus fo reground. A techn ique 
I picked up from Colin Varndell. 1 must say I was 
delighted that it was selected for a ribbon: my first 
within the DIG. 
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RIBBON WINNER. JUDGE: HILARY ROBERTS FRPS 

FISHING CABINS AT DAWN 

Hila ry Roberts FRPS: This image appealed 
strongly to me as soon as it was put up because the 
atmosphere in it is just overwhelming. l am not 
often up at dawn, and I didn't know fishing cabins 
ex isted - I wonder if Geoff is a fisherman or just 
someone who knows a good location when he 
spots it and is prepared to suffer for his an? Either 
way, the result is superb. and the more you look at 
it the better it gets. The light is so beautiful; the 
misty background, the illuminated cabin. the way 
it catches the bushes or plants on the sandbank -
and the texture of the water in the foreground is 
exquisite. 
Geoffrey Lea LRPS: The photograph was taken 
on a tidal stretch of the river Rance in Brittany 
France. 
The original shot was taken in daylight and was a 
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Geoffrey Lea LRPS 

reasonable image but lacked real impact One fe lt 
that it could be improved and as is my normal way 
with such images I noted down what the needs 
were to make that significant leap from ordinary 
to someth ing that had both impact and 
atmosphere. The enhancements that I noted were. 
tide out to reveal the mud contours and dramatic 
early morning light combined with autumn mist. 
They all came together one October morning. The 
ill umination of the glass in the cabin was a bonus 
that f had not foreseen but one that completely 
finished the picture. (Not as a number of judges 
have commented. that the photographer was lucky 
they left the lights on) 
For reference - the i111age was taken on a Canon 

5D with a 28 - 135 lens at the I 35m/m end 
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MEMBERS' EXHIBfflON 2009 

A Face in the Crowd Alan Abercrombie FRPS 

Cowherd Nonnan Wiles LRPS 

Rebecca Nonna Phillips LRPS 

Aloof Tony Poole ARPS 

Joceline with Palm 
Professor Peter Hernmem LRPS 
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For S Parkinson 1771 Tony Healy AR.PS 

Fromage Jackie Thompson LRPS 

Eastern Promise Shirley Britton ARPS 

Poppies under lhc Olive Tree Elizabeth Restall LRPS 
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Abandoned Alison Cawley LRPS 

Winter Reeds Peter Chance LRPS 

H 

Broken Fence Phi l Drake FRPS 

John Long ARPS 

Paladian Bridge, Stowe Arnold Hubbard FRPS 
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MEMBERS' EXBIBtflON 2009 

River of Blood Roger Holman ARPS 

Aqua Vitae Roger Norton LRPS 

City Street Ken Biggs FRPS 

Tulips Jim Buckley LRPS 

Cubic View of the Moors John Lacey ARPS Newtongrange Mining Museum Montage Andy Wanstall 
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Leopard Warrior Les Swnmers 

Jmminent Arrest John Scotten A RPS Toward the Door Ray Reeves 
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MEMBERS' EXHIBfflON 2009 

The Circus, Bath Jeffrey Bartlett ARPS 
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Country Tools 
David Britton 

In Sherbrooke Forest 
Dr Peter Gawthrop ARPS 

The Battle of Britain Memorial Window Bert Crawshaw ARPS 
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Early Snow 

The Forgotten 

Secret Place - Abbey 
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Robe11 Albright FRPS 

Sharon 

Andy Beel FRPS 

Shelagh Robe11s FRPS White-Out 

Robert Croft LRPS 

George Hodlin ARPS 
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MEMBERS' EXHIBfflON 2009 

Lady Train Driver 

On Guard 
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Ron Pain LRPS 

Ron Holmes ARPS 

Smokey Conversation 
Sylvia Kislingbury ARPS 

Toolmaker Anne Gilmore LRPS 

Hair Today, Gone Tomon-ow 
Ian Boulton LRPS 
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Yellow Darter Olga Davidge LR.PS Two Jaguars Stan Stubbs LR.PS 

Pelican Preening John Lewis LRPS 
Another Close Race John Buries FRPS 

Wings Barbara Summers 

RPS DIGIT Magazine Summer 2009 37 



38 

MEMBERS' PRINT EXBIBfflON 2009 

Bath Abbey 

Aswan 

George fley ARPS 

Beach Walkers 
Guy Davies ARPS 

Cesi Jennings LRPS 

Fallen Tree Covehithe Alan Cross LRPS 

II 

Shell Bay Dorset Eric Leeson LRPS 
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Hands ofa Veteran Graham Whistler FRPS 

Two by Two Bob Pearson FRPS 

Boy and Kinens Margaret Salisbury FRPS 
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Etcmal I-lope 

Coming Home 

Sweeper in the Arches 

Dr David Cooke LRPS 

Adrian Smithson LRPS 

Rosemary Wilman ARPS 
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Fallen Gold Ian Ledgard LRPS 

Sea Creatures Walter Easter LRPS 

Somewhere in France Doreen Haines LRPS 
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Steam Farming 

Sheringham Fishing Boats 

James Foad 

Alan Dedman LRPS 
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Towards Infinity Ronald Walter ARPS 

The Old Red Waggon 2 Dr John Nathan LRPS 

RPS DlGIT Magazine Summer 2009 

Fuxin Stabling Point 

Stairway Design 

Tan Silvester ARPS 

Peter Davidge LRPS 
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MEMBERS' EXBIBfflON 2009 

Accessories Jeanne Bradban LRPS 

The Boots Joanne Searle ARPS 

Weeping Woman Rod Poxon LRPS 
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Deep in the Wood 

Black CoumTy Museum 

Dust 

Jim Marsden FRPS 

Mel Stallwoithy LRPS 

Vanessa Herring LRPS 
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Morning Light on Inch Strand 

It's not a Lampost 
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Professor Brian Cooke ARPS 

Fem with Lines and Curves 
Carole Lewis ARPS 

Malcolm Kitto ARPS The Pianist's Chair 

Shelter on the Pier 
Christine Carr LRPS 

Nick Ayers ARPS 
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MEMBERS' EXHIBfflON 2009 

Millennium Eye 

Shadow Cycl ists 
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Ian Bateman FRPS 

Adrian Hen-ing ARPS 

Great Sands. Colorado 

J 

t ., 

Nuts 

St Ma1y·s, l-lunon 

Ron Morgan LRPS 
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Clifford Brown LRPS 
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The Yellow Sea 

Blue on Blue Paula Davies FRPS 

Creek Men Peter Read LRPS 
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Buttermere, Cumbria 

Reflection 

Before Sunrise 

Eric Cleavely LRPS 

Jean Pain LRPS 

Anne Mahany ARPS 
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Ch ld of the Reef Len Deeley FR PS 

Two Trees 
Carol Wiles ARPS 

Companions Clive Haynes FRPS The Model Dennis Hancock LRPS 
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Tree and Cloud Rod Smith ARPS 

Strolling in Lnfrared Herbert Housley ARPS 

Winter Walk Baron Woods FRPS Sand, Surf and Sky Sheila Read FRPS 
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A DAY WITH STEVE CAPLIN 25 OCTOBER 2009 
The Old School House, Smethwick Photo Society at Churchbridge, Oldbury, West Midlands B69 2AX 

Easy access from MS, Junction 2 by car with ample parking, and by public transport from Birmingham International or 
New Street and Sandwelt and Dudley stations. See http://www.theoldschoolhouse.com for map and routes. 

Reality and musion 
The DI Group's major conhibution to the Society's The Real Thing series and a day you will not want to miss. 
We are fo1tunate to have digital imaging illustrator and Photoshop special-techniques and amazing 
manipulations specialist Steve Caplin to present an outstanding programme. Steve is a well-known author -
How to Cheat in Photoshop and Art and Design in Photoshop amongst others - and lecturer. Starting with a 
print competition with prizes; the day features Steve's views on the ethics of photographic manipulation with 
current and historical examples; his assessment and constructive advice about some of your prints and images; 
and a Photoshop workshop demonstration and question sess ion to round off an entertaining and practical event. 

PROGRAMME 
I 000 onwards Coffee and biscuit and a chance to see the RPS International Print Exhibition on display. 
Members' prints displayed for instant competition 
1100 Introduction and judging of prints. 
1130 Steve Caplin on Reality and lllusion: Staging, Manipulation and Photographic Truth 
1300 Lunch - Full Bar Bring your own or pre-order sandwiches - see below 
1400 Steve Caplin assesses members' prints, and images submitted electronically, with manipulation or montage 
1500 Steve Caplin on Photoshop BRlNG YOUR PRINTS AND SEND fM AGES ELECTRONICALL v 
1630 Questions and discussion Full infonnation available from the DI Group website at www.digit.rps.org in Events 
1700 Tea and biscuit and close or email to editor@digit.rps.org 

~ 
~ __ .... __ -,---.-- . ----------------. -------------------. _-,--.---.--.--.---.--.--.-------------. _-,--.---.--. ----------------.--.--.---. ------.---.--.---.---.--.-----· - -~ 

Lunch and Images Booking Form 
Reality and Illusion: A Day with Steve Caplin Sunday 25 October 2009 

I will bring a print (on a mount 40x50cm) for the competition and potential assessment D 
I will submit an electronic image for potential assessment D 

Sandwiches 
- see website for details or email: editor@digit.rps.org 

I would like: D cheese on white; D cheese on brown 
D ham on white; D ham on brown sandwiches at £2 each = £ 

Enclosed cheque for sandwiches payable to the RPS DI Group for £ Please tick D 

Name: RPS Member No ------------------------
Address: 

Post Code ----
Email address: ________________ Telephone __________ _ 

Please book your ticket directly with the Society at reception@rps.org or by phone on 01225 325733 
DI Group members £7.50, all others £12 

Send Lunch and Images booking form above with your cheque for sandwiches payable to RPS DI Group to: 
DIGIT, 1 Aldenholme, Weybridge, KT13 OJF 
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